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WEBSITE TERMS AND CONDITIONS 

1. WELCOME TO OUR WEBSITE 

This Website can be accessed at www.sstlaw.co.za , related mobi-sites and software applications 

(the “Website”) and is owned and operated by Stroebel, Singh and Theunissen Inc (Registration 

No: 2005/023918/21) and Stroebel, Singh and Theunissen North Inc (Registration number:  

2014/100285/21)(“the Company”, “we”, “us” and “our”).  

2. NOTICE 

2.1 These Website Terms and Conditions (“Terms and Conditions”) govern the use of the 

Website. 

2.2 These Terms and Conditions are binding and enforceable against every person that accesses 

or uses this Website (“you”, “your” or “user”), including without limitation each user who 

uses a self-help smart assessment. By using the Website and by clicking on the “Accept” 

button on the Website, you acknowledge that you have read and agree to be bound by 

these Terms and Conditions. 

2.3 You must not use this Website if you do not agree to the Terms and Conditions.  the 

Company reserves the right to prevent your usage of this Website if you misuse the contents 

contained within this Website in any manner. The Company is the final arbiter as to what 

shall constitute misuse and its decision will be final.   

2.4 We reserve the right to amend these Terms and Conditions at any time without prior notice.  

3. CONTACTING US 

3.1 The Company is registered in South Africa as a private company with limited liability and its 

registered office and details are as follows:  

Physical Address 

6 NJ VAN DER MERWE CRESCENT, SASOLBURG, 1947 

7TH FLOOR, MENLYN CENTRAL OFFICE PARK, 125 DALLAS AVENUE, MENLYN MAINE, 0181 

Postal Address 
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PO BOX 18, SASOLBURG, 1947 

7TH FLOOR, MENLYN CENTRAL OFFICE PARK, 125 DALLAS AVENUE, MENLYN MAINE, 0181 

Republic of South Africa 

3.2 For the purposes of the Electronic Communications and Transactions Act (Act no. 25 of 

2002) (“ECT Act”), the Company’s information is as follows, which should be read in 

conjunction with its product descriptions and other terms and conditions contained on the 

Website: 

3.2.1 Full name: STROEBEL, SINGH AND THEUNISSEN INCORPORATED (Registration Number: 

2005/023918/21) and STROEBEL, SINGH AND THEUNISSEN NORTH INCORPORATED 

(Registration Number: 2014/100285/21) 

3.2.2 Main business: Rendering of legal services 

3.2.3 Physical address for receipt of legal service: As above 

3.2.4 Directors: Louis Daniel Marthinus Stroebel, Louis Daniel Marthinus Stroebel, Ashmini 

Singh, Anna Francina Theunissen 

3.2.5 Phone number: +27 16 976 0420 

3.2.6 Official email address: info@sstlaw.co.za  

3.2.7 PAIA: The manual published in terms of Section 51 of the Promotion of Access to 

Information Act (Act no. 2 of 2000), incorporating the provisions of the Protection of 

Personal Information Act (Act no. 4 of 2013) may be downloaded from 

www.sstlaw.co.za. 

3.3 You can get in touch with us: 

3.3.1 via the contact section of this Website; 

3.3.2 by mail or email at the addresses specified above; 

3.3.3 by telephone during normal office hours (Monday – Thursday 8 am to 4pm and Fridays 

8 am to 3pm) excluding public holidays in the Republic of South Africa) on our number 

listed above (your call may be recorded). 
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4. ACCURACY AND AVAILABILITY 

4.1 Whilst we always do our very best to ensure the information shown on the Website is 

accurate and up to date, we give no warranty or undertaking as to the quality, or freedom 

from error, of the contents of this Website. We expressly exclude liability for any such 

inaccuracies or errors to the fullest extent permitted by law. 

4.2 We will use reasonable endeavours to maintain the availability of the Website, except 

during scheduled maintenance periods, and are entitled to discontinue providing the 

Website or any part thereof with or without notice to you. 

4.3 The Company may in its sole discretion terminate, suspend and modify this Website, with 

or without notice to you. You agree that the Company will not be liable to you in the event 

that it chooses to suspend, modify or terminate this Website other than for processing any 

orders made by you prior to such time, to the extent possible. 

4.4 If you fail to comply with your obligations under these Terms and Conditions, this may (in 

our sole discretion with or without notice to you) lead to a suspension and/or termination 

of your access to the Website without any prejudice to any claims for damages or otherwise 

that we may have against you. 

4.5 The Company is entitled, for purposes of preventing suspected fraud and/or where it 

suspects that you are abusing the Website and/or have created multiple user profiles to 

engage in any unlawful activity, to blacklist you on its database (including suspending or 

terminating your access to the Website), refuse to accept or process payment of any 

products,  on notice to you.  

4.6 At any time, you can choose to stop using the Website, with or without notice to the 

Company. 

5. USE OF THE WEBSITE 

5.1 It is possible to view our Website without providing any personal information as defined in 

the Protection of Personal Information Act (“Personal Information”). However, if you use 

the “Contact Us” button or use our self-help smart assessment, you will be required to 

provide certain Personal Information. By completing and submitting a “Contact Us” request 

on the Website, or using a self-help smart assessment, you are expressly permitting the 

Company to collect, collate, process and use your Personal Information for the purpose it 
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was provided, as well as to disclose it to our service providers (if any) and only if selected by 

you. 

5.2 We also collect demographic and profile data on our Website. This may be combined with 

other forms of information to permit us to bring together, in aggregate form, information 

about the people who use our Website. Such information will enable us to understand, in 

general terms, user preferences in relation to the content of the Website and the 

effectiveness of the advertising. 

5.3 The Company will not share, sell or loan any identifiable information about you to any third 

party without your express consent. We may share generalised information about site 

visitor patterns with partners or other parties in such a way that individual visitors can never 

be identified. 

5.4 Unfortunately, the transmission of information via the Internet is not completely secure and 

we cannot guarantee the security of data transmitted to or from our Website. Once we 

receive your information, we will use strict procedures and security measures to protect 

your information and to prevent unauthorised access to it. 

5.5 The Company is the “data controller” for purpose of the ECT Act.   

5.6 The Company will store your Personal Information in a secure hosting facility in the Republic 

of South Africa, but off-site from our corporate head office. The Company will store your 

Personal Information only for the purpose for which it was collected as well as a record of 

any third party to whom the Personal Information was disclosed, the reason for disclosure 

and the date of the disclosure, for the duration that your information is used and for a 

period of 1 (One) year thereafter as required by Section 51(5) and (7) of the ECT Act.  After 

the 1 (One) year period as aforesaid, the Company will delete or destroy (as applicable) all 

your Personal Information that is stored that has become obsolete. 

5.7 You may request details of Personal Information that we hold about you by requesting the 

Company in writing to furnish you with such information. Our security procedures mean 

that we may request proof of identity in providing you with these details, dependent on the 

Personal Information that you request. We will notify you of this after we have received 

your request. If you wish to submit a written request as outlined above then please contact 

us using the contact particulars below.  If all reasonable steps have been taken to find a 

record as requested and there are reasonable grounds for believing that the record is in the 
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Company’s possession, but cannot be found, or does not exist, the head of the Company 

will by way of affirmation notify you that it is not possible to give access to that record. 

5.8 Your email address is only used for the purposes of replying to you unless you have given 

consent as detailed above.  

5.9 Whenever you browse our Website, read pages, or download information, our computers 

automatically record certain information about your visit from the computer you use to 

access our Website. This information does not identify you personally. It just tells us how 

many visitors come to our Website and the types of computers they use. With this 

information, we can improve our Website for all our visitors and make it more useful to you. 

The information includes the following: 

5.9.1 the date and time you access our Website; 

5.9.2 how many and which pages you visit during a 'session' on our Website and how long 

you were on the Website; 

5.9.3 your Internet domain name (this might be your internet service provider such as 

aol.com or your place of work) and the 'IP' address (this is a number assigned to your 

computer whenever you are surfing the web) which allows you to access our Website;  

5.9.4 the Internet browser you use (e.g. Microsoft Explorer or Netscape) and your 

computer's operating system (e.g. Windows 10);  

5.9.5 the site you were on before you linked to our Website (e.g. Yahoo if you found us from 

a search engine).  

6. COOKIE POLICY 

6.1 WHAT IS A COOKIE? 

6.1.1 A cookie is a text-only string of information that a Website transfers to the cookie file 

of the browser on your computer's hard disk so that the Website can remember who 

you are.  

6.1.2 Cookies can help a Website to arrange content to match your preferred interests more 

quickly - most major Websites use cookies. Cookies alone cannot be used to identify 

you. A cookie will typically contain the name of the domain from which the cookie has 
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come; the "lifetime" of the cookie; and a value, usually a randomly generated unique 

number.  

6.2  TWO TYPES OF COOKIES ARE USED ON OUR WEBSITE:  

6.2.1 Session Cookies, which are temporary cookies that remain in the cookie file of your 

browser until you leave the site.  

6.2.2 Persistent Cookies, which remain in the cookie file of your browser for much longer 

(though how long will depend on the lifetime of the specific cookie, how cookies are 

used on this site and what information is collected).  

6.2.3 Session Cookies are used: 

6.2.3.1 To allow you to carry information across pages of our site and avoid having to re-

enter information.  

6.2.3.2 Within registration to allow you to access stored information.  

6.2.4  Persistent Cookies are used: 

6.2.4.1 To help us recognise you as a unique visitor (using a number, you cannot be 

identified personally) when you return to our Website.  

6.2.4.2 To allow us to tailor content or advertisements to match your preferred interests 

or to avoid showing you the same adverts repeatedly. 

6.2.4.3 To compile anonymous, aggregated statistics that allow us to understand how 

users use our site and to help us improve the structure of our Website. We cannot 

identify you personally in this way. 

6.3 Google AdWords 

6.3.1 The Company also tracks cookies by way of Google AdWords remarketing features that 

track such cookies. 

6.3.2 By visiting the Company’s Website, you agree that certain of our Google AdWords 

remarketing or other advertisements can follow you as you visit other Websites that 

are part of Google’s Display Network (GDN). 
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6.3.3 We shall not share with third parties or utilise any Personal Information as obtained in 

our Google AdWords remarketing campaign in any other marketing initiatives. 

6.3.4 You may opt out of seeing advertisements for this Website by clicking here: 

http://www.google.com/policies/technologies/ads.  

6.4 THIRD PARTY COOKIES 

6.4.1 Third parties serve cookies via this Website. These are used for the following 

purposes:  

6.4.1.1 to serve advertisements on our Website and track whether these advertisements 

are clicked on by users; 

6.4.1.2 to control how often you are shown a particular advertisement;  

6.4.1.3 to tailor content to your preferences; 

6.4.1.4 to count the number of anonymous users of our Website; 

6.4.1.5 to provide security within shopping baskets or transactions.  

6.5 WEB BEACONS 

6.5.1 Some of our web pages may contain electronic images known as Web Beacons 

(sometimes known as clear gifs) that allow us to count users who have visited these 

pages.  

6.5.2 Web Beacons collect only limited information which includes a cookie number; time 

and date of a page view; and a description of the page on which the Web Beacon 

resides.  

6.5.3 We may also carry Web Beacons placed by third party advertisers. These Beacons do 

not carry any personally identifiable information and are only used to track the 

effectiveness of a particular campaign.  

6.6 DISABLING AND ENABLING COOKIES 
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6.6.1 You have the ability to accept or decline cookies by modifying the settings in your 

browser. However, you may not be able to use all the interactive features of our 

Website if cookies are disabled.  

6.6.2 Should you wish to be alerted before a cookie is accepted on your hard disk, you can 

follow the guideline instructions below: 

6.6.3 If you are using Netscape Navigator 3.0:  

6.6.3.1 Go to the 'Options' menu  

6.6.3.2 Click 'Network Preferences'  

6.6.3.3 Click 'Protocols'  

6.6.3.4 Tick the box that says 'Show an alert before accepting a cookie'  

6.6.3.5 Go into your Netscape folder 

6.6.3.6 Delete the file that is called 'cookies.txt', this will delete all the cookies  

6.6.3.7 Under Windows 95, you should also use the 'Find' feature on the 'Start' menu to 

simply find the file called 'cookies.txt.' 

6.6.4 If you are using Internet Explorer 3.0: 

6.6.4.1 Go to the 'View' menu  

6.6.4.2 Click 'Options'  

6.6.4.3 Click 'Advanced'  

6.6.4.4 Tick the box that says 'Warn before accepting cookies' 

6.6.4.5 Go to cookies directory * Delete all the files you have there, this will delete all 

cookies  

6.6.4.6 Once you delete these files you will have no more cookies, and you will be 

prompted each time a Website attempts to send a cookie to your system. At that 

time, you can choose to either 'Accept' or 'Cancel' a cookie 
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6.6.5 If you are using Netscape 4.0+:  

6.6.5.1 Go to 'Edit' in the menu bar   

6.6.5.2 Click on 'Preferences' 

6.6.5.3 Click on 'Advanced'   

6.6.5.4 Tick the box that says 'Warn me before accepting a cookie'  

6.6.5.5 Now go to your 'Start' button  

6.6.5.6 Click on 'Find'  

6.6.5.7 Click on 'Files and Folders'   

6.6.5.8 Type "cookies.txt" into the search box that appears 

6.6.5.9 Click 'Find Now'  

6.6.5.10 When the search results appear drag all files listed into the 'Recycle Bin', this will 

delete all cookies  

6.6.5.11 Now shut down and restart Netscape  

6.6.5.12 Once you delete these files, you will have no more cookies, and you will be 

prompted each time a Website attempts to send a cookie to your system. At that 

time, you can choose to either 'Accept' or 'Cancel' the cookie 

6.6.6 If you are using Internet Explorer 5.0+:  

6.6.6.1 Go to the 'Tools' menu   

6.6.6.2 Click on 'Internet Options'  

6.6.6.3 Click the 'Security' tab  

6.6.6.4 Highlight the 'Internet' zone (selected by default)  

6.6.6.5 Select security level 'High' for this zone  

6.6.6.6 Click on 'OK'   
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6.6.6.7 Go into your cookies directory  

6.6.6.8 Delete all the files you have there, this will delete all cookies   

6.6.6.9 Once you delete these files, you will have no more cookies and your browser will 

no longer send or receive new cookies.  

6.6.7 If you are using Netscape 6.0+:  

6.6.7.1 Go to 'Edit' in the menu bar  

6.6.7.2 Click on 'Preferences'  

6.6.7.3 Select the 'Cookies' field  

6.6.7.4 Before Accepting a Cookie' or 'Disable Cookies'  

6.6.7.5 Click on 'OK'  

6.6.7.6 Go to your 'Start' button  

6.6.7.7 Click on 'Files and Folders'  

6.6.7.8 Type "cookies.txt" into the search box that appears  

6.6.7.9 Click 'Find Now'   

6.6.7.10 When the search results appear drag all files listed into the 'Recycle Bin', this will 

delete all cookies  

6.6.7.11 Now shut down and restart Netscape  

6.6.7.12 Depending on your earlier choice you will either be prompted by new cookies or 

no cookies will be set or received 

6.6.8 If you are using Internet Explorer 6.0+:  

6.6.8.1 Go to the 'Tools' menu  

6.6.8.2 Click on 'Internet Options'  

6.6.8.3 Click the 'Privacy' tab  



 PAGE 12 of 15 

6.6.8.4 Move the slider to choose your preferred settings  

6.6.8.5 Click on 'OK'  

6.6.8.6 Go into your cookies directory  

6.6.8.7 Delete all the files you have there, this will delete all cookies  

6.6.8.8 Once you delete these files, you will have no more cookies and your browser will 

no longer send or receive new cookies 

6.6.9 If you are using Netscape 7.0+:  

6.6.9.1 Go to 'Edit' in the menu bar   

6.6.9.2 Click on 'Preferences'  

6.6.9.3 Click on ' Privacy & Security'  

6.6.9.4 Select the 'Cookies' field  

6.6.9.5 Choose your preferred settings  

6.6.9.6 Go to your 'Start' button  

6.6.9.7 Click on 'Find'  

6.6.9.8 Click on 'Files and Folders'  

6.6.9.9 Type "cookies.txt" into the search box that appears  

6.6.9.10 Click 'Find Now'   

6.6.9.11 When the search results appear drag all files listed into the 'Recycle Bin', this will 

delete all cookies Now shut down and restart Netscape  

6.6.9.12 Depending on your earlier choice you will either be prompted by new cookies or 

no cookies will be set or received 

6.7 DELETING COOKIES  
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You can easily delete any cookies that have been installed in the cookie folder of your 

browser. For example, if you are using Microsoft Windows Explorer:  

6.7.1  Open 'Windows Explorer'  

6.7.2 Click on the 'Search' button on the tool bar  

6.7.3 Type "cookie" into the search box for 'Folders and Files'  

6.7.4 Select 'My Computer' in the 'Look In' box  

6.7.5 Click 'Search Now' * Double click on the folders that are found  

6.7.6 'Select' any cookie file  

6.7.7 Hit the 'Delete' button on your keyboard  

6.7.8 If you are not using Microsoft Windows Explorer, then you should select "cookies" in 

the "Help" function for information on where to find your cookie folder. 

7. DATA PROTECTION ON PIXEL TAGS  

7.1 We may use "pixel tags," which are small graphic files that allow us to monitor the use of 

our Websites.  

7.2 A pixel tag can collect information such as the IP (Internet Protocol) address of the computer 

that downloaded the page on which the tag appears; the URL (Uniform Resource Locator) 

of the page on which the pixel tag appears; the time the page containing the pixel tag was 

viewed; the type of browser that fetched the pixel tag; and the identification number of any 

cookie on the computer previously placed by that server. 

7.3 When corresponding with you via HTML capable e-mail, we may use "format sensing" 

technology, which allows pixel tags to let us know whether you received and opened our e-

mail. 

8. JURISDICTION AND LAW 

8.1 This Website is intended for the use of our Clients in the Republic of South Africa only. It 

was created and is operated according to the laws of the Republic of South Africa.  
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8.2 These terms and our relationship and/or any dispute arising from or in connection with 

these terms will be governed and interpreted in accordance with the laws of the Republic 

of South Africa. Your continued use of the Website will constitute your consent and 

submission to the jurisdiction of the South African courts regarding all proceedings, 

transactions, applications or the like instituted by either party against the other, arising from 

any of these terms. 

8.3 Nothing within these terms is intended to, nor will it, limit your right to approach any court, 

tribunal or forum of competent jurisdiction in terms of the Consumer Protection Act. 

9. CHANGES TO THE TERMS AND CONDITIONS 

9.1 The Company may, in its sole discretion, change any of these Website Terms and Conditions 

at any time. It is your responsibility to regularly check these Terms and Conditions and make 

sure that you are satisfied with the changes. Should you not be satisfied, you must not in 

any way continue to use the Website. 

9.2 Any such change will only apply to your use of this Website after the change is displayed on 

the Website. If you use the Website after such amended Terms and Conditions have been 

displayed on the Website, you will be deemed to have accepted such changes. 

10. UNDERTAKINGS  

10.1 You are permitted to browse this Website and we also encourage you to download and 

share elements with your friends and family for personal and information use. However, 

you are not allowed to reproduce extracts by way of printing, downloading or by distribution 

to other people for business use, or create any hyperlink or other similar form of connection 

to this Website without our express written permission. The use of this Website within any 

other Website by the use of framing or otherwise is strictly prohibited. 

10.2 You agree that you will not in any way use any device, software or other instrument to 

interfere or attempt to interfere with the proper working of the Website. In addition, you 

agree that you will not in any way use any robot, spider, other automatic device, or manual 

process to monitor, copy, distribute or modify the Website or the information contained 

herein, without the prior written consent from an authorised the Company representative 

(such consent is deemed given for standard search engine technology employed by Internet 

search Websites to direct Internet users to this Website). 
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11. COPYRIGHT 

11.1 The contents of the Website, including any material, information, data, software, icons, text, 

graphics, lay-outs, images, sound clips, advertisements, video clips, trade names, logos, 

trade-marks, designs and service marks which are displayed on or incorporated in this 

Website (“Website Content”) are protected by law, including but not limited to copyright 

and trade mark law. The Website Content is the property of the Company, its advertisers 

and/or sponsors and/or is licensed to the Company. 

11.2 You will not acquire any right, title or interest in or to the Website or the Website Content. 

11.3 Any use, distribution or reproduction of the Website Content is prohibited unless expressly 

authorised in terms of these Terms and Conditions or otherwise provided for in law.  

11.4 Where any of the Website Content has been licensed to us or belongs to any third party, 

your rights of use will also be subject to any terms and conditions which that licensor or 

third party imposes from time to time and you agree to comply with such third party terms 

and conditions. 

12. DISCLAIMER 

12.1 The use of the Website is entirely at your own risk and you assume full responsibility for any 

risk or loss resulting from use of the Website or reliance on any information on the Website. 

12.2 Whilst the Company takes reasonable measures to ensure that the content of the Website 

is accurate and complete, the Company makes no representations or warranties, whether 

express or implied, as to the quality, timeliness, operation, integrity, availability or 

functionality of the Website or as to the accuracy, completeness or reliability of any 

information on the Website. If any such representations or warranties are made by the 

Company’s representatives, the Company shall not be bound thereby. 

12.3 The Website itself and all information provided on the Website is provided “as is” without 

warranty of any kind, either express or implied, including, but not limited to, the implied 

warranties of merchantability, fitness for a particular purpose, completeness, or non-

infringement, as may be allowed in law. 

12.4 Any views or statements made or expressed on the Website are not necessarily the views 

of the Company, its directors, employees and/or agents. 


